
Zarafa User Manual

Client side configuration and usage.





Zarafa is a workgroup sharing solution based on the look-and-feel of Microsoft Outlook, which 
enables the sharing of mail and appointments from Outlook and a web-based interface.

This manual describes the basic features of Zarafa from a user's point of view. You can use this manual 
for Zarafa 6.30.0 and later.
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1  Zarafa Webaccess

1.1  Basics
The Zarafa webaccess is by default accessible via http://<ip-address>/webaccess.

Webaccess is available in several languages which you can select on the login screen. 
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Screenshot 1: Login screen

After you log in, you have access to all your Outlook folders and the Public folders. The most basic 
functions are available in the top bar of the Webaccess. See screenshot 2.

Via the right mouse button you can access some extra functionalities of the various folders. 

Screenshot 2: Menu "New"

1.2  Create/rename/move/copy/delete folder
To create, move, rename, copy or delete a subfolder you can use the right mouse menu in the folderlist.

.
Screenshot 3: Context menu from a folder

It is not possible to delete, move, or rename default Outlook folders such as Inbox, Calendar or 
Contacts. 
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1.2.1  Printing

In the Webaccess you can print your email, appointments, and contacts with the print button: 

After opening a calendar in the day, week or month view, it is also possible to print these as an 
overview.

1.2.2  Resizing panes

Just like in Outlook it is possible to resize the panes in Webaccess so you can setup the width and 
height of the workspace in each pane manually. To do this: place the mouse between two panes en 
drag the pane border to the location you wish.

1.2.3  Empty deleted items folder

You can empty the Deleted Items folder via the right mouse button menu option “Empty folder”. This 
option is only available in the right mouse button menu of the “Deleted Items” folder and the Junk Email 
folder (if it exists). 

1.2.4  Restore items

When deleting an item in the Deleted Items folder or Junk folder, the item is still  temporarily 
recoverable. Select the Deleted Items folder or Junk folder, and use the button “Restore Item” in the bar 
at the top. In this new window you can restore all or a selection of the deleted items. The restored items 
will be placed in the old location. If you delete the items from this window, the items are gone 
permanently. 

Screenshot 4: Softdelete folder

1.2.5  Marking all messages in a folder as read

You can mark all the messages in a folder as read via the right mouse button menu option “Mark All 
Messages Read”. Please note that when you choose this option, no read receipts will be sent when 
requested by a sender, even if you have selected that option in your settings.

1.2.6  Properties

Via the right mouse button menu option “Properties” additional information about a folder can be seen. 
The data usage and the number of items in this folder are shown in this new window. For more details 
about the data size, use the button “Folder size...”. Here you can see a list containing all subfolders in 
the folder with the data size used per subfolder. 

1.3  Access to folders and calendars for other users
Just like in Outlook, in Webaccess permissions can be set on folders that allows them to be shared with 
colleagues and others.

The permissions can be found by right clicking on a folder and choosing the “Properties” option, and 
then selecting the “Permissions” tab on the window that appears.
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Screenshot 5: Permissions

1.3.1  Add a person

•Click on the “Add” button under the Permissions tab.

•When the Address Book pops up, select the person you want to give permissions to and click “Ok”. 
The name will then be added to the permissions list.

•Please note that you must change this persons’ permissions below or else he has no extra rights.

•Click “Ok” to save and close the permissions window.

1.3.2  Change permissions

•Click on the person whose permission you want to change.

•Now you can either manually set the permissions in the bottom part of the permissions window, or you 
can select one of the preset profiles from the Profile drop-down menu.

•Click “Ok” to save and close the permissions window.

1.3.3  Remove a person

•Click on the person you wish to remove from the list.

•Click on the “Remove” button

•Click “Ok” to save and close the permissions window.

1.3.4  Open shared folders

It's possible to open shared folders via Webaccess. By clicking the “Open shared folder” button in the 
folder list, you will get a window that looks like screenshot 6.
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Screenshot 6: Open shared folders

You can open a single folder, (for example the calendar folder), or you can open the complete folder list 
of a specific user. 

The opened folders are stored in your Webaccess profile, so the next time you login to Webaccess the 
opened folders are still available.

To close an opened folder, you can use the “Close store” option in the right mouse button menu. 

1.4  Email

1.4.1  Send new email

1.Select the button “New” in the left corner. You will the see the new email window

Screenshot 7: Create email 

2.You can add attachments to the email by selecting the “Attachment” button or the “Paperclip” icon

3.You can save the email by selecting the “Floppy disk” icon. After you have saved the email, it is stored 
in the “Drafts” folder.

4.To set a flag that marks the email as important or high priority, click on the  “exclamation mark” ( ! ) 
icon.

5.To add a recipient you can either add their email address in the TO, CC, or BCC field manually, or you 
can select a person from the Address Book.  To access the Address Book, click on the TO, CC or BCC 
button.

Note: When more than one recipient is added, you need to separate the email addresses with a 
semicolon.

6.In the Address Book you will see the internal users by default (unless you have selected otherwise in 
Settings). By using the “Show names from the:” drop-down menu, you can choose to view contacts from 
one of your personal contacts folders or a Public contact folder. You can also quick search a folder by 
using the search field in the top left of the window.
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Screenshot 8: Address Book

Note: Since 6.30.0 it is possible to add company-wide defined addresslists in the Address Book. Read 
the Server manual for more details regarding addresslists.

1.4.1.1  Automatic email address suggestion

When typing an email address or contact information in the TO, CC or BCC fields the system 
automatically gives you suggestions based on your input. These suggestions are listed below and you 
can select a suggestion by using the mouse or keyboard. The suggestions are based on email 
addresses and contact information that have been used recently.

It is possible to delete an address from this list by moving the selection to the address in question (by 
either using the keyboard arrows or by placing the mouse over it without clicking) and then pressing the 
'Delete' key. The address is removed, but when it is used again it will show up in the list once more.

Screenshot 9: Automatic suggestions

1.4.1.2  Set the sender address ( 'from' field)

It is possible to set the FROM address of an email you are sending. This field can be found above the 
TO field. When no address has been selected the default address is used.

Screenshot 10: Selecting a from address

Please note that the FROM field is only displayed when FROM addresses have been set in the settings 
dialog, which is located at the bottom right of the screen. (After opening Settings, click on the Compose 
Mail tab).
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Screenshot 11: Adding From addresses

Important note: If the following (bounce) message is returned when sending an email not as yourself, 
please contact your administrator:

“You are not allowed to send as the given user.”

Since Zarafa 6.20 two kinds of delegation are available:

•Send on Behalf permissions: if a user grants the appropriate permission to another 
user, the latter can send items 'on behalf of' the other user. In this case an email or 
meeting request will be sent with the following From: field: <delegate> on behalf of 
<user>.

•Send As permissions: if the system administrator gives the rights to user B to 'send 
as' user A, the receiver of an email will not see that user B sent an email. The receiver 
will only see user A in the From: field

Before version 6.20, a user could enable send on behalf of permissions. This meant 
letting a user send an email 'on behalf of' another user from inside the inbox of the 
other user. You could always see who sent the email. For example: Pete enters the 
inbox of 'info' and sends an email as the non-active user 'info', you would see: 
“pete@example.com on behalf of info@example.com”.

Since 6.20 it is possible to send emails as other users without the 'on behalf of' part. 
Due to security reasons the new 'send as' permission is only configurable by the 
administrator on the server side. This setting can always be overruled by the user 
itself and the old 'on behalf of' permission can still be set by the user. See chapter 2.6 
how to set the user based 'on behalf of' delegation and/or overruling of the admin 
based 'send as' delegation.

Keep in mind that delegation always overrules impersonation. A user can always 
choose not to let another user impersonate as himself.

1.4.1.3  Saving an email to drafts

Saving an email is possible by selecting the “Floppy disk” icon;  After saving the email, it is stored in the 
“Drafts” folder. Another option is to automatically save an unsent email. This option is available under 
the 'compose mail' tab in the settings window. To do this, check the option “Autosave unsent every: X 
minutes”. The number of minutes that Webaccess will routinely automatically save the email in the 
“drafts” folder can be entered too. This is only applicable when the email isn't sent yet. 

1.4.2  Inline images

Zarafa 6.30 has the ability to add inline images in mail messages. To add an inline image, click on 
'Attachments' and select an image. If the 'HTML' format is being used (see 'Compose mail in this format' 
in 'Settings', 'Compose mail' tab), the inline image functionality is enabled. A light blue cross icon will 
appear beside the attachment (Screenshot 12). Click on the icon to insert the image in the body mail 
(Screenshot 13). The inline image will be positioned in the last cursor position.
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Screenshot 12: Light blue cross icon to insert the image as a inline image

Screenshot 13: Inline image

To change the image size, right click on the image and select 'Image properties'. A popup will  appear 
(Screenshot 14) that enables the user to customize width and height of the image and options such as 
border and alignment.

Screenshot 14: Image properties editor

It is possible to delete the inline image directly from the main body, as if it were text.
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1.4.3  Delete/move/copy email

Screenshot 15: Context menu from a mail message

1.4.3.1  Delete email

There are several ways to delete email. They are:

•Via the delete button on your keyboard

•Via the delete button in right mouse button menu

•Via the red cross button in the top bar of the webaccess

1.4.3.2  Move email

To move a single item, use the Drag&Drop feature. Place the mouse cursor over the item to be moved, 
click and hold the left mouse button. Continue to hold the button down while moving the mouse cursor 
until it is over the folder the message needs to be placed.

Screenshot 16: Moving email

Notice that the folder names under the mouse cursor are highlighted while moving. This highlighting 
marks the folder where the message will be placed when releasing the button. 

To move multiple items, first select all the items (you can only move items that are currently visible). To 
select a range of items click on the first item and then press and hold the shift button on the keyboard. 
Before releasing the shift button, use the mouse to click on the last item in the range that needs to be 
moved.  All items between the two items clicked on will become highlighted. 

With items that are not consecutive, hold down the control (<Ctrl>) button on the keyboard while clicking 
on each item. To drag and drop these items, release the control button, place the mouse cursor on one 
of the selected messages, and Drag&Drop them into the designated folder. 
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Items can also be moved by clicking on the copy/move button as displayed in screenshot 17.

1.4.3.3  Copy email

To copy an item, the Drag&Drop feature can not be used, it does not duplicate them. Use the 
copy/move button (See the section above about moving multiple items for an explanation concerning 
how to select multiple items).

Screenshot 17: Copy/Move button

1.4.3.4  Change email view

Screenshot 18: Context menu from a mail view column

In Webaccess, the email view has a default layout. However, like in Outlook, change the view by adding 
or removing columns. 

To do this, click on From with the right mouse button and select the Field Chooser.

Screenshot 19: Field Chooser

Additionally, sort your email by selecting a specific column. By default the email is sorted by date.

1.4.4  Searching

When you need to find a message you can click on the “Search” button in the top menu bar.  A search 
bar will then be added to the WebAccess view (To remove the search bar, click the Search button 
again).

p.12



Screenshot 20: Searching options

Here you can type your search query and choose where you want to search. For example if you 
remember part of the subject of the message you are looking for, you can select “Subject” from the pull 
down menu. You can then click on the “Search button” (binoculars icon) or press the enter button on the 
keyboard, and the mail list will be updated so that it only shows messages with your search words in the 
subject. (screenshot 20)

Screenshot 21: Search results

When you are finished searching you can press the “Clear” button (red circle icon) to return to the 
normal view with all your messages.  When you want to remove the search bar, you can click on the 
“Search” button in the top menu bar.

1.5  Calendar usage

1.5.1  Create new appointment with invitations and free/busy status

1.Select the folder Calendar.

2.Select the button “New” to create a new appointment. You will see a new appointment window 

Screenshot 22: New appointment
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3.Insert a subject for the appointment, and if necessary a location. 

4.Select a start and end time for the appointment.

5.Optional: enable the reminder option, you'll get a reminder pop-up before the appointment starts. The 
time interval before the reminder and the appointment is adjustable in the field next to the reminder 
option. When it is time for the reminder to pop-up, Webaccess should show a list of these reminders 
with an option to open the item, dismiss the item, dismiss all items and to “snooze” the reminder event 
by a given time.

Note: You need to enable pop-ups in your browser to get the reminder pop-up. 

Screenshot 23: Reminder dialog

1.Via the button “Invite Attendees” you can send a meeting request to a colleague (screenshot 24). You 
can add other attendees by adding their email addresses. The email addresses need to be separated 
by a semicolon. Via the “To” button you can select contacts from your Address Book. The attendee will 
receive a meeting request which the attendee can accept, tentative, decline, or propose a new time for 
the meeting.

Screenshot 24: Meeting request

1.By selecting the tab “Scheduling”, you see the free/busy times for multiple people. In this view you can 
easily schedule a meeting for several colleagues and see exactly when a specific person is busy, out of 
the office, or available. If attendees are invited for this appointment, and the attendee has proposed a 
new date or time for the meeting, a list of proposals will be shown.
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Screenshot 25: Scheduling/FreeBusy

Screenshot 26: Attendee or resource option

2.Colleagues can be added via the “Add a name” field.

3.If a user has been added as an attendee, you can mark that user as either required to attend that 
meeting or as an optional attendee. It is also possible to schedule the user as a resource - like a room 
or a piece of equipment - needed for that meeting.

4.In the Tracking tab a list with all attendees for this appointment with the status of the responses can 
be found.

Screenshot 27: Tracking tab

1.5.2  Accept a meeting invitation

If someone invites you for a meeting, you will receive meeting invitation. At the top of the invitation a bar 
containing the buttons “accept”, “tentative”, “decline” and “Propose New Time” are displayed for sending 
a response to the owner of the appointment. 

Screenshot 28: Meeting invitation buttons

Choosing “Propose a new time” will propose a new date or time to the owner. The owner receives the 
proposal and will decide whether he is going to agree or not.
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1.6  Multiple calendar views
The webaccess calendar has five different views:

•Day view

•Workweek view

•Week view 

•7 day view (like the Workweek view, but with 7 days)

•Month view

Views can be switched via the four buttons in the top bar of the webaccess. 

Screenshot 29: Calendar view

To switch the view to another day/week/month you can use the date picker, which is at the top right of 
the screen with arrows on both sides.

1.6.1  Move/delete appointment

1.6.1.1  Move appointment

You can move an appointment to another time/date by selecting the item and moving it to the correct 
date via Drag&Drop. If the new date is not in your view, you can open the appointment (either by double 
clicking on it or by right clicking on it and choosing the Open option) and then select a new date.

1.6.1.2  Delete appointment

You can delete an appointment via the delete button in the right mouse button menu or via the “Delete” 
button in the top bar of the webaccess.

1.7  Multi User Calendar
With the Multi User Calendar you can open the calendar from another user. It's also possible to see 
multiple calendars from different users in one overview. Click on “Open Multi User calendar” to go to this 
view. 

Note: This feature is not available in the community version of Zarafa.
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Screenshot 30: Multi User Calendar

1.7.1  Adding a user to the time line

1.Click on the button “Add User” in the bar at the top.
The Address Book window will open.

Screenshot 31: Timeline

2.Click on a user to select that person and click on the button “OK”

3.The user is added to the time line and the appointments are loaded.

1.7.2  Deleting a user from the time line

Select the user by clicking on the check box in front of their name. Click on the button “Remove User” in 
the bar at the top.

Screenshot 32: User groups
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1.7.3  Loading a group of users to the time line

1.Click on the button “Load Group...” in the bar at the top. A Group Window will open.

2.Select a group in the left list and click on the button “OK”.

3.The group of users is added to the time line and the appointments are loaded per user.

1.7.4  Load group dialog

The “Load Group” dialog can be opened by clicking on the button “Load Group” in the bar at at the top. 

The dialog consists of two lists. The list to the left shows the different groups that have been created. 
The list to the right displays all the users that are members of a particular group when that group has 
been selected from the left list. 

To add or delete a group or user use respectively the plus or minus buttons on the right side of the list. 
Remember that you must select a group prior to adding or removing a user.

1.7.5  No Access message

When you have added a user to the time line it is possible that you do not have the permissions 
necessary to create appointments in their calendar or you might not even be allowed to see the content 
of their folder all together. When you are not permitted to create an appointment an icon is placed after 
the name as an indicator. When you have no access to the calendar at all, the entire time line for that 
user is marked in red and a warning message appears.

Screenshot 33: No Access message

1.7.6  All attendees/Free busy bar

The bar above the time lines contains the cumulative free/busy information of the users loaded in the 
Multi User Calendar. The bar also shows whether the appointments are set as “Tentative”, Busy” or 
“Out of Office”.

Screenshot 34: All attendees/Free busy bar
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1.7.7  Create or delete an appointment

To create an appointment you have to double click on the time line of the user you want to create an 
appointment for. This will open a new appointment window where the appointment can be created

To delete an appointment you have to open the appointment first and then use the red cross  to delete 
it.

1.7.8  Dragging appointments

To drag an appointment you have to click and hold down the left mouse button on an appointment and 
move the mouse over the time line to the desired location and release the mouse at that point. To help 
place the appointment an red overlay follows the mouse to indicate the point and the time the item will 
be placed when the mouse is released at that point.

Screenshot 35: Dragging appointments

It is also possible to drag the appointment to the store or other users, if you have the permissions to do 
so. Simply move your mouse to that store and the red overlay will follow, when you are allowed to 
create an appointment in the other calendar.

1.7.9  Changing zoomlevel

It is possible to quickly zoom in on the time line by changing the zoom level using the drop down box in 
the top left corner of the Multi User Calendar. This setting is not saved and will be reseted to the default 
setting (as set in your settings dialog) next time the Multi User Calendar is opened

Screenshot 36: Zoomlevel

1.7.10  Changing number of displayed days

To change the number of days that are loaded in the time line and to change the number of days that 
are visible at the same time (zoom level) you have to open the settings dialog. Under the tab “Calendar” 
the “Multi User Calendar View” options can be found. These settings will be used whenever you open 
the Multi User Calendar. 

Screenshot 37: Buttons for changing time period
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1.7.11  Browse time period

To change the period that is shown in the time line you can use the previous/next buttons on the bar at 
the top. You can either move 1 day or an entire period (1 period is the number of days which are loaded 
in the timeline) back or forth.

1.8  Tasks
In the task folder a to-do list can be created and managed. Use the follow steps to create a task.

1.Select the folder “tasks”

2.Use the button “New” to create a new task. A new task window will be shown.

Screenshot 38: New  task window

3.Fill in the preferred fields. The fields in this window are comparable with the “new appointment” 
window.

4.Use the “Save” button to confirm. The task can now be found in the task overview.

Another way to make new tasks is available in the task overview (screenshot 39). The upper task in this 
list has an empty subject. Enter a task directly into the empty field and confirm with ENTER on the 
keyboard. This way, making a task can be done quite easy and fast.

Screenshot 39: Task overview

1.9  Contacts
The contacts folders have multiple views. You can displays the contacts in a card view or a list view. 
You can switch between these views with the buttons in the top bar. 

You can send an email directly to a contact via the right mouse button menu option “Email Message”. 
Via the letters at right side of the contact view you can see all the contacts that start with a specific 
letter.
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Screenshot 40: Contacts

1.9.1  Create new contact

You can create a new contact via the “New” button in the top bar of the webaccess.

In the “New contact” window you can fill in all the information about the contact.

With the option “Private”, in lower right corner, you can hide the contact from colleagues that have 
access to your Contact folder

1.9.2  Detailed Contacts

Since Zarafa 6.30 the Webaccess provides a detailed dialog for contacts. 

1.Go to the contacts section of the Webaccess

2.To add a new contact, click the “New” button in the top bar. To edit an existing contact, double click on 
a contact item.

 
Screenshot 41: New/Edit Contact 

3.In the Contact window, buttons are available instead of labels; click on a button and the detailed 
dialog box for that particular field will appear.

4.The detailed dialog boxes for Full Name, Phone Number and Address are shown in Screenshots 
42and 43.
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Screenshot 42: Name details dialog and Phone details dialog

Screenshot 43: Address details dialog

5.In the name and address dialogs a check box is provided in order to give the possibility to have the 
dialog automatically shown if the name or address should be incomplete or not clear.

6.There are three types of address fields (Home, Business, Other). To change between these 
addresses, use the cascade menu that appears when clicking on the small arrow situated beside the 
address field.

Screenshot 44: Cascade menu to choose the address type

7.In this menu, a tick is shown beside the type of address that contains information; this way it is 
possible to know which addresses have already been entered.

8.Different types of phone fields are now available in Webaccess. To change the phone type use the 
cascade menu that appears by clicking on the small arrow near the phone number field.(Screenshot 
45). Also in this menu, a tick is shown beside the type of phone that contains information.
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Screenshot 45: Cascade menu to choose the phone type

1.10  Distribution lists
Using a distributionlist when creating a mail, can be done by using the same steps as adding contacts to 
an e-mail, by selecting the distributionlist from the addresslist. After selecting the distributionlist, all 
mailaddresses will be placed in the chosen field header.

1.10.1  Creating new distribution lists

1.Select the Contact folder you want to add the new distribution list  to and select the option “Distribution 
list” from the “New” menu button.

Screenshot 46: New Distribution list window

2.With the button “Select Members” you can select contacts from the Address Book to add to the 
distribution list.

3.With the button “Add new” you can create a new contact to add to the distribution list by specifying a 
Name and an Email address..
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Screenshot 47: Add new address dialog

4.With the button “Remove” you can remove selected contacts from the distribution list. You can select 
contacts by clicking on them in the lower part of the window.

5.You can also add a note to the distribution list on the “Notes” tab page.

1.11  Public Folder Favourites
To have a useful shortcut to the most used public folders use the Favourite folder that can be found 
under the public folders tree. In order to add a folder to the Favourite folder, right click on a public folder 
and select 'Add to favourite folder'. The 'Add to Favourite Folder' window will appear (Screenshot 48):

•Fill in a name for the favourite folder (by default the same name will be given to the folder)

•By default only the selected folder will be inserted in the favourite folder without subfolders. It is 
necessary to specify otherwise.

Screenshot 48: 'Add to favorite folder' window

1.12  Rules
When you want Webaccess to automatically organize your email as it arrives you can use the “Rules” 
feature. With this function you can set up server side rules to move/copy incoming messages to other 
folders, send the incoming message to an other person, or directly delete the incoming message.

To create and edit rules you must first open the Rules dialog by clicking on the “Rules” button in the 
menu bar. This button is only available when you have a mail folder selected.

Screenshot 49: Rules button

You will get a dialog window as in screenshot 50. In this dialog you can create, modify and delete rules. 
It is also possible to change the order of the rules in case you have multiple rules which could match the 
same message. To do this you must select the rule you want to move and click on the “Up” or “Down” 
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button.

When you want to disable a rule but not delete it, you can uncheck the rule by clicking on the checkbox 
in front of the rule. Only the “checked” rules will be executed upon the arrival of new mail. When you are 
done you must click the “Ok” button to save the changes to the server.

Screenshot 50: Rules overview dialog

To create a new rule, click on the “New” button in the rules overview dialog. You get the dialog shown in 
screenshot 51.  This is the same dialog as when you want to change a rule by selecting a rule from the 
rules overview dialog and clicking on the “Edit” button. 

In the add/edit dialog you can type a short description of the rule in the “Rule name” field. You can later 
identify the rules by this name in the rules overview dialog.

Next you can enter the criteria for the rule. You can choose to match an incoming message by the 
sender of the message, a part of the subject, the priority it has, to whom it has been sent, or if the 
message has been only sent to you. You can also combine these criteria to get a better match for the 
rule you are creating.  (All the criteria you fill in must be fulfilled in order for an email to be seen as 
matching the rule). Please note that although it is possible to combine both the “sent to”  and the “sent 
only to me” criteria, it is possible that by doing so the rule will not work, because they can contradict 
each other.

You can use the buttons behind the input fields to open the Address Book and select an email address.

Screenshot 51: Add/edit rules dialog

Next you must define what to do with the matching message. You can move or copy the message to an 
other folder, you can delete the message directly, or you can forward the message to another person.

When you select the move/copy action you must specify the destination folder by clicking on the 
underlined text. This will open the folder list where you can select a folder.
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Finally you can close this window by clicking on the “Ok” button. To save the rule, you must close the 
rules overview dialog by clicking “Ok”.

1.13  Settings
In the lower right corner of the Webaccess you can open the “Settings” window.

Screenshot 52: Settings: Preferences

In the Settings window you can set the following options:

•Default Language (screenshot 52)

•Color theme: at this time only silver and the default blue are available (screenshot 52)

•New mail check timeout: by default the webaccess will check every 5 minutes for new email. If new 
mail is available a new mail notification will be shown in the right corner of the webaccess, and the 
counter of unread messages in the folder tree will be updated. (screenshot 52)

•Automatic logout: Use this option when you want to increase security and logout the webaccess 
automatically if it goes unused for the specified amount of time. (screenshot 52)

•Startup folder: The folder that is displayed when you login to the webaccess. (screenshot 52)

•Number of items displayed per page. (screenshot 52)

•Reading pane position. (screenshot 52)

•Reply-to address (screenshot 53)

•Mail format: you can format your email in Plain text as well as HTML (screenshot 53)

•Read receipts: send read receipts with every email (screenshot 53)

•Autosave unsent every: ... minutes (screenshot 53)

•Close original message on reply/forward (screenshot 53)

•Always add signature to outgoing mail (screenshot 53)

•Edit signature... (open the signature window) (screenshot 53)

•Out of Office message

•The size of calendar items in the day views

•Specify working hours

•Set the default Address Book
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Screenshot 53: Settings: Compose mail

Screenshot 54: Settings: Signatures

1.13.1  Signatures

If the option “Always add signature to outgoing mail” is enabled, every email will have a signature at the 
end of the text body. In the signature window multiple signatures can be created and/or managed. Use 
the following steps to create and use a signature:

1.Click on 'edit signature..' in the 'compose mail' tab. The “Signature” window will appear. (screenshot 
54).

2.Click on the 'new' button and enter a name for the signature in the pop-up box and click on 'OK'.

3.Select the just created signature in the list and edit the signature in the text box below. If the mail 
format is set to HTML ('Settings'→  'Compose Mail' tab → 'Compose mail in this format'→ select HTML 
from the cascade menu), HTML signatures can be used. For example, it is possible to create a 
signature with image and text. Click on 'Save' to save the signature.  
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Screenshot 55: HTML signature 

4.Different signatures can be used; for new messages and for reply & forward messages. Choose in the 
drop down menu in the right of the window which signature is preferred. 

5.Click on 'OK' at the bottom to close the window and to confirm the new signature settings. 

1.14  Firefox Extensions
Two Firefox extensions are available for download on the Zarafa website

1.14.1  Zarafa Attachment Drag and Drop Extension 

By installing this plug-in it is possible to Drag&Drop files on a new mail in order to attach them. It is 
possible to drag&drop a single file or a selection of multiple files.

1.14.2  Zarafa New Mail Notification Extension

The zarafa mail-checker extension allows the users to check their Zarafa Inbox without opening the 
Webaccess or Outlook. A Zarafa icon will be present on the bottom rightmost corner of the Firefox 
browser and will inform the users about incoming mail .

A double click on the icon will redirect the user directly to the webaccess.

1.14.2.1  Settings

With a right-click on the Zarafa icon the extension's settings are accessible (Screenshot 56).
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Screenshot 56: Zarafa Mail-checker extension settings

•It is possible to activate or deactivate the plugin.

•It is necessary to fill in the url of the Webaccess and the username.

•The advanced settings allow the user to personalise the plug-in by changing the time interval for mail 
check and enabling/disabling the notification for new mail. It is also possible to specify where the 
Webaccess must be opened when double clicking on the Zarafa icon and enable/disable the automatic 
login to the Webaccess.

1.15  Advanced Webaccess options

1.15.1  Webaccess as default mail client

Since Zarafa version 6.20 it is possible to set Webaccess as the default email client. Below are three 
examples to set Webaccess as the email client to use when a user clicks on a link containing “mailto:”

1.15.2  Examples Windows

In Windows (for all users):

Windows Registry Editor Version 5.00

[HKEY_LOCAL_MACHINE\SOFTWARE\Clients\Mail\Zarafa Web Client]
@="Zarafa Web Client"

[HKEY_LOCAL_MACHINE\SOFTWARE\Clients\Mail\Zarafa Web Client\DefaultIcon]
@="%windir%\\zarafa.ico"

[HKEY_LOCAL_MACHINE\SOFTWARE\Clients\Mail\Zarafa Web Client\Protocols]

[HKEY_LOCAL_MACHINE\SOFTWARE\Clients\Mail\Zarafa Web Client\Protocols\mailto]
"URL Protocol"=""

[HKEY_LOCAL_MACHINE\SOFTWARE\Clients\Mail\Zarafa Web 
Client\Protocols\mailto\DefaultIcon]
@="%windir%\\zarafa.ico"

[HKEY_LOCAL_MACHINE\SOFTWARE\Clients\Mail\Zarafa Web 
Client\Protocols\mailto\shell]

[HKEY_LOCAL_MACHINE\SOFTWARE\Clients\Mail\Zarafa Web 
Client\Protocols\mailto\shell\open]
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[HKEY_LOCAL_MACHINE\SOFTWARE\Clients\Mail\Zarafa Web 
Client\Protocols\mailto\shell\open\command]
@="rundll32.exe url.dll,FileProtocolHandler 
http://<SERVER>/<USER>/mailto/index.php?action=mailto&to=%l"

[HKEY_LOCAL_MACHINE\SOFTWARE\Clients\Mail\Zarafa Web Client\shell]

[HKEY_LOCAL_MACHINE\SOFTWARE\Clients\Mail\Zarafa Web Client\shell\open]
@="Zarafa Web Client"

[HKEY_LOCAL_MACHINE\SOFTWARE\Clients\Mail\Zarafa Web Client\shell\open\command]
@="rundll32.exe url.dll,FileProtocolHandler 
http://<SERVER>/<USER>/mailto/index.php?action=mailto&to=%l"

[HKEY_LOCAL_MACHINE\Software\Classes\mailto]
"EditFlags"=hex:02,00,00,00
"URL Protocol"=""
@="URL:MailTo Protocol"

[HKEY_LOCAL_MACHINE\Software\Classes\mailto\DefaultIcon]
@="%windir%\\zarafa.ico"

[HKEY_LOCAL_MACHINE\Software\Classes\mailto\shell]

[HKEY_LOCAL_MACHINE\Software\Classes\mailto\shell\open]

[HKEY_LOCAL_MACHINE\Software\Classes\mailto\shell\open\command]
@="rundll32.exe url.dll,FileProtocolHandler 
http://<SERVER>/<USER>/mailto/index.php?action=mailto&to=%l"

In windows (for current user only):

Windows Registry Editor Version 5.00

[HKEY_CURRENT_USER\SOFTWARE\Clients\Mail\Zarafa Web Client]
@="Zarafa Web Client"

[HKEY_CURRENT_USER\SOFTWARE\Clients\Mail\Zarafa Web Client\DefaultIcon]
@="%windir%\\zarafa.ico"

[HKEY_CURRENT_USER\SOFTWARE\Clients\Mail\Zarafa Web Client\Protocols]

[HKEY_CURRENT_USER\SOFTWARE\Clients\Mail\Zarafa Web Client\Protocols\mailto]
"EditFlags"=hex:02,00,00,00
"URL Protocol"=""
@="URL:MailTo Protocol"

[HKEY_CURRENT_USER\SOFTWARE\Clients\Mail\Zarafa Web 
Client\Protocols\mailto\DefaultIcon]
@="%windir%\\zarafa.ico"

[HKEY_CURRENT_USER\SOFTWARE\Clients\Mail\Zarafa Web 
Client\Protocols\mailto\shell]

[HKEY_CURRENT_USER\SOFTWARE\Clients\Mail\Zarafa Web 
Client\Protocols\mailto\shell\open]

[HKEY_CURRENT_USER\SOFTWARE\Clients\Mail\Zarafa Web 
Client\Protocols\mailto\shell\open\command]
@="rundll32.exe url.dll,FileProtocolHandler 
http://<SERVER>/<USER>/mailto/index.php?action=mailto&to=%l"

[HKEY_CURRENT_USER\SOFTWARE\Clients\Mail\Zarafa Web Client\shell]

[HKEY_CURRENT_USER\SOFTWARE\Clients\Mail\Zarafa Web Client\shell\open]
@="Zarafa Web Client"

[HKEY_CURRENT_USER\SOFTWARE\Clients\Mail\Zarafa Web Client\shell\open\command]
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@="rundll32.exe url.dll,FileProtocolHandler 
http://<SERVER>/<USER>/mailto/index.php?action=mailto&to=%l"

[HKEY_CURRENT_USER\Software\Classes\mailto]
"EditFlags"=hex:02,00,00,00
"URL Protocol"=""
@="URL:MailTo Protocol"

[HKEY_CURRENT_USER\Software\Classes\mailto\DefaultIcon]
@="%windir%\\zarafa.ico"

[HKEY_CURRENT_USER\Software\Classes\mailto\shell]

[HKEY_CURRENT_USER\Software\Classes\mailto\shell\open]

[HKEY_CURRENT_USER\Software\Classes\mailto\shell\open\command]
@="rundll32.exe url.dll,FileProtocolHandler 
http://<SERVER>/<USER>/mailto/index.php?action=mailto&to=%l"

1.15.2.1  Installing the.reg file: 

1.Open registry file in notepad then remove this line:

2.“http://<SERVER>/<USER>/mailto/” and put your zarafa server's path there.

3.install registry file supplied (for current user or for all users of system).

4.In outlook 2003/2007 go to Tools → Options → Other → uncheck “Make outlook the default program 
for Email, Contacts & Calendar”.

5.Also open run command and type %windir%, it will open your default windows folder

6.copy and paste zarafa.ico in that folder. The icon can be found on the server in the following place: 
.../webaccess/client/layout/img/favicon.ico

1.15.3  Example in Linux

1.Make a new script file mailto.sh.

2.Put the following lines in the file:

#!/bin/bash

ADDRESS=`echo $1|cut -f 2 -d : -`

# Logs this to syslog... just helps to make sure it is working properly
logger "Opening Zarafa mail client, addressed to $ADDRESS"

firefox "http://<SERVER>/<USER>/mailto/index.php?action=mailto&to=$ADDRESS"

3.Replace “http://<SERVER>/<USER>/mailto/” with your your server's path

4.Save the file in /home/yourusername/, then 'chmod uog+rwx mailto.sh' the file from a console.

5.Now type "gnome-default-applications-properties" on a console or go to System>Preferences>More 
Preferences>Preferred Applications.

6.In mail reader change to custom and specify the path of mailto.sh file path would be /home/<USER>/
mailto.sh %s. 

1.15.4  Adding Zarafa WebAccess as 'mailto' handler in Firefox

When clicking an URL of an email address (a 'mailto' address) in Firefox it will try to open a mail client 
for you. Firefox has a list of possible mail client to use, with the possibility to pick a default. To use the 
Zarafa WebAccess to handle 'mailto' URLs in Firefox follow the these steps:

1.Type "about:config" in the address bar and press Enter. Ignore the warranty warning.
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2.Put "gecko.handlerservice" in the filter box.

3.Double-click "gecko.handlerServiceAllowRegisterFromDifferentHost". This will change its value from 
'false' to 'true'.

4.Paste this code in the address bar while replacing "https://URL/TO/YOUR/ZARAFA/WEBACCESS" 
with the URL you use to access your installation of the Zarafa WebAccess (usually the url you use to 
get to the login screen of the WebAccess), then press Enter: 

javascript:window.navigator.registerProtocolHandler("mailto", 
"https://URL/TO/YOUR/ZARAFA/WEBACCESS&url=%s","Zarafa WebAccess")

5.Below the address bar a message asking if you want to add the Zarafa WebAccess as an application 
to handle 'mailto' links. Click the "Add Application" button.

6.Next time you click a mailto: link, a screen will appear that lets you choose an appropriate application. 
Select the Zarafa WebAccess, and if you wish check the box next to "Remember my choice for mailto: 
links", then click OK.

From now on you can use the Zarafa WebAccess directly when clicking mailto links in Firefox. Please 
note that you have to be logged in (or make use of Single Sign On) for it to work smoothly.

2  Zarafa Outlook client

2.1  Installation of the Outlook client
There are two requirements that must be fulfilled prior to installing a Zarafa workspace.  First, you need 
Outlook 2000 or higher, and second, the user must be created on the Zarafa Server.

The following steps are necessary to install a Zarafa workspace:

Note: It is recommended to have the latest Service Packs and Security patches installed.

1. Install the client;

− Assure Outlook is set as default email application; Control panel > Internet > Applications.

− Put the Zarafa CD in the drive, wait for the automatic start of the CD and choose the uppermost 
option: Windows Client. Or, if you got the client from another source:

Doubleclick the file zarafaclient.msi

If you use Outlook XP (2002) or 2003, follow the instructions step 2a.
If you use Outlook 2000, follow the instructions in step 2b.
If you use Outlook 2007, follow the instructions in step 2c.

Note: With version 5.10, Zarafa is introducing an MSI installer for the Zarafa client instead of an .exe 
installer. If you are upgrading from a Zarafa version prior to 5.10, we advise you to remove the 
older Zarafa client before running the new MSI installer. If you do not remove the old client you 
will have two Zarafa clients visible in the Windows software list.

Note: Version 5.xx of the Zarafa client is not compatible with a version 6.xx Zarafa server. With 
version 6.00, Zarafa will ask during the installation if you want 
to update the existing files. Select this option if you do not 
connect to a Zarafa 5.2x server anymore.

2a. Create a new mail profile (Outlook XP and 2003):

•Go to Control Panel -> Mail -> Show Profiles...
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•Click on Add... and fill in a title, for example “Zarafa”. Click OK.

Add a Zarafa Server to this profile (Outlook XP and 2003)

•Choose Create a new mail account and click Next -> in the dialog window that appears after adding the 
profile (or after choosing Email Accounts... in Outlook or the Mail setup).

•Choose the last option (Extra server types) and click Next ->. Then choose Zarafa 6 Server and click 
Next -> again.

•The window shown on the right will appear.

•Fill in the address or host name of the server in the Server field.

•Optionally: choose HTTPS connections where available. 

•Fill in the login data of the user in the Username and Password fields.

•Choose the connection type, there are 3 different possibilities:

•Online
•Cached Zarafa mode
•Detect at Startup

Note: More information the 3 connection types can be found below in the section ‘Outlook 
connection type’.

Note: Outlook XP only has the Online type to select.

•Choose OK a couple of times to close the windows.

2b. Create a new mail profile (Outlook 2000):

•Go to Control Panel -> Mail

•Click Add profiles... and choose Configure information services manually and Next ->.

•Choose a profile name, for example “Zarafa” and click Next ->.

•Click on Add... -> Zarafa Server -> OK in this Window.
The window shown in section 2a will appear.

•Fill in the address or host name of the server in the Server field.
Optionally: choose HTTPS connections where available. 

•Fill in the logon data of the user in the Username and Password fields.

•Now click Add.. -> Outlook address book -> OK.

•Click OK.

2c. Create a new mail profile (Outlook 2007):

•Go to Control Panel -> Mail -> Show Profiles...

•Click on Add... and fill in a title, for example “Zarafa”. Click OK.

•Select the option 'Manually configure server settings or additional server types' and click on Next.

•Select Other, and choose Zarafa Server and click Next.

•The window shown in section 2a will appear.

•Fill in the address or host name of the server in the Server field.

•Optionally: choose HTTPS connections where available. 

•Fill in the logon data of the user in the Username and Password fields.

•Click Ok. The personal folders of this user and the public folders will appear as store in Outlook after 
adding the server in this way.
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•Click on Finish to finalise the profile.

3. Start Outlook.

•Start Outlook and make sure the added profile is being used.
This can be set in Control panel -> Mail -> Profiles... on the bottom of the dialog window.

•The private mailbox of the entered user and the public folder will appear as a store in Outlook.

2.2  Outlook connection type
By default Outlook has an ongoing connection to the Zarafa server and does not store the folders and 
items on the local hard drive. With the introduction of Zarafa 6.00, you have the ability to synchronise all 
your private Outlook data to your local hard drive, so you can easily access your email, agenda and 
contacts if you do not have an internet connection.

The following three options are available for the connection to the server:

2.2.1  Online

The Online type works the same as in the previous versions of Zarafa. When you have a network 
connection to the server, you can start your Outlook. When the network connection is not available you 
cannot access your email, agenda and contacts.

2.2.2  Detect at startup

With the Autodetect Offline / Online type Outlook checks at startup if the server can be reached. When 
Outlook has a connection to the Zarafa server all your items will be synchronised to your offline storage. 
When your network connection is lost, Outlook will not automatically switch to its offline storage. You 
need to restart Outlook to switch to your offline storage.

When you start Outlook and there is not a network connection available, Outlook produces a pop-up 
that asks if you want to work offline.

2.2.3  Cached Zarafa Mode

The third type of connection is Cached Zarafa Mode.This type similar to the caching mode of MS 
Exchange. If you select this type, you will always work on your offline storage. When there is a network 
connection available all your items will be synchronised to your offline storage. The first time you 
configure your Outlook profile it is necessary to have a connection to your Zarafa server. After your 
profile is created and you start Outlook, all your folders and items will be synchronised.

2.2.4  What is the best connection type to choose?

Type of user Zarafa profile type

User that always works on the same fixed PC in the office Online

User that uses roaming profiles and logs in on different fixed PC's 
in the office

Online

User that works with a fixed PC remote from a sub department 
over a small bandwidth internet connection

Cached Zarafa Mode

User with a laptop that is inside the office most of the time. Detect at startup

User with a laptop that is always out of the office Cached Zarafa Mode

User that works on a Terminal Server Online

Table 1: connection type options
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2.3  Using the Zarafa Outlook client
The Zarafa Outlook client does not change the way you work with Outlook significantly. However there 
are some extra features available to you as a result of Outlook using a central Zarafa server for storage.

2.3.1  Working offline

With Zarafa version 6 you will be able to work offline without using additional tools, like the Zarafa 
Livesync. The Zarafa Livesync tool is replaced by the Offline options in Zarafa version 6.

After starting Outlook in the “Cached Zarafa Mode” or the “Detect at startup” mode you will have an 
extra synchronisation plugin available in Outlook.

The synchronise button will show a progressbar during the synchronisation.

Screenshot 57: synchronisation plugin buttons

You can schedule the synchronisation time by using the configure button.

When you start the first synchronisation, it will begin first with your Global Address Book.
After the Global Address Book has been synchronised, it will synchronise your Inbox. The most recent 
emails will be synchronised first.

During the initial synchronisation you will not receive any new email.  Your new email will be retrieved 
after the first synchronisation is finished or after you restart Outlook during the sync. Sending new email 
during synchronisation, however, will be done immediately.

2.3.2  Sending email during offline use

When you send email during offline use, the email will be kept in the Outbox. To send the email when 
you have a connection to the server again, you need to select the “Send & Receive” button.

You can also schedule this action by configuring the send & receive settings:
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Screenshot 58: Send and receive settings

2.3.3  Important things about Offline options:

•It is not possible in the current version to synchronise the favourite folders of the Public Folder or 
delegate mailboxes.

•Public Folders and delegate mailboxes will be directly opened from the server, like the Online Zarafa 
modus.

•The synchronisation of a mailbox of 1000Mb will take around 1 hour when you have a 100Mb/s network 
connection to your Zarafa server

•When you are offline you can not open shared mailboxes or set security permissions on folders

•In a Cached Mode profile the button “Open other user's folder” is disabled.

•At the moment you can only open shared mailboxes and calendars via the button “Open shared 
folders” or via the button “Open a shared calendar” in the calendar section of Outlook

•You can not open the Public Folder after being offline; the session is not available on the server. To 
open the Public Folder again, it is necessary to restart your Outlook to setup a new session.

2.3.4  The creation of a public folder

By default, every user is able to create folders and items in the Public folders. However, the permissions 
on these new items are set so that a new folder can only be read by other users.

To enable others to write to the folder, you must set the correct permissions; for example allow writing 
and deleting by the group Everyone. (See Sharing of folders).

2.3.5  Sharing of folders (setting permissions)

The permission structure has been built with flexibility in mind. It is possible to set permissions per 
folder. Every folder inherits the permissions of the folder it is located in. Every item inherits the 
permissions of the folder it is contained in.

Before a folder can be added and viewed by other users, the permissions have to be set correctly.

To accomplish this, right click on a folder and choose Properties.

  
Screenshot 59: Set folder permissions

In the appearing dialog window you can choose different settings regarding the properties of the folder. 
The last tab window contains the permissions settings.

At the top is a list with users and the permissions which have been set. After selecting a user the rights 
can be selected at the bottom. Choosing a profile from the drop down list makes this easier by 
automatically selecting often used settings.
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Users can be added and deleted with the two buttons below the user list.

For example, to give user Pete the rights to read and write to items in a folder, you first click Add.... After 
selecting Pete and clicking OK, Pete will show up in the list.  After this the right checkboxes can be set; 
to enable reading and writing only select Read items and Edit items on All.

Permissions Description
Create items The user can create items
Read items The user can read items
Edit all items The user can edit all items
Edit own items The user can only edit their own items
Delete all items The user can delete all items
Delete own items The user can only delete their own items
Create subfolders The user can create subfolders
Folder visible The user can view the folder 
Folder permissions The user can change permissions on the folder

Table 2: explanation of permissions

If there are no check boxes selected for a user, then denying permissions are in effect and the user can 
not access the folder.

By default a user only has read/write permissions on their own folders and is able to create folders in 
the Public Folders.

The owner is saved with every item.  This way, depending on the set permissions, a user is only allowed 
to delete their own items and not items belonging to other users. The owner of the mail box can always 
edit or delete all items in his/her mail box, regardless of the owner of the items.

It is possible to give administrative rights to users, after which they have access to the entire Zarafa 
system. These administrators have the ability to change the permissions on public folders and the 
folders of each user on the system. Also, every folder or item can be opened by an administrator.

Note: changed since 5.10: All Access Control Lists (ACL’s) on a folder are added together for the user. 
The rights that are given to groups are thus added to grant the user all the rights they may 
receive through these groups. This will give the user the maximum combination of access rights 
that have been configured for the user and for the groups the user is a member of.

2.3.6  Adding or opening folders shared by other users

To add shared folders of other users and to be able to write to or read from it, the following steps should 
be executed:

Click in Outlook on File and Open Shared Folders....

Screenshot 60: File menu.

Choose in the dialog window the user and the type of folder to be opened, then click OK.

Screenshot 61: User and folder selection.
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If you choose Inbox (permanent), then not only a folder be opened but an extra mail box will be added in 
the folder list of Outlook.  This folder will appear in a separate Outlook window with the folders 
described as (temporary).

It is only possible to read or write to this folder after the owner has given the rights to do so. See the 
previous paragraph about setting permissions.

2.3.7  Adding and removing stores of other Zarafa users

In order to delete mail boxes (also called stores) which were added to the list of mail boxes in the folder 
list of Outlook, the user must do the following:

1.Click with the right mouse button on a mail box:

Screenshot 62: Folder Properties selection.

2.Select Properties. Then click Advanced.... Select the tab Advanced in the Zarafa server dialog 
window.

Screenshot 63: Zarafa server dialog.

3.Click Remove to remove or Add to add a mail box.

After clicking Add, select a user to add his/her store and let the store appear in the folder list of Outlook.

2.3.8  Restoring deleted items

Because Zarafa uses a so-called Soft Delete system, items you remove from your view in Outlook can 
still be restored. You can open this view by selecting Tools > Recover Deleted Items.
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Screenshot 64: Recovering deleted items.

Select the items you want to recover and click on the Restore button to restore the items to the folder 
they were deleted from. Most items will be restored to the Deleted Items folder.

If you select Delete, the items will be truly removed from the server, and you will not be able to recover 
these items. The server has a lifetime on these items, so after a set period of time, the items will be 
removed.

2.3.9  Free/Busy updates

When you create new appointments in your calendar, the Zarafa client will update your Free/Busy 
information. This update will occur some time after you created the appointment or the moment you 
close Outlook. Other users will not directly see this change in their Free/Busy overview.

When you create an appointment, you may also invite other people. If you add other users, the overview 
will be updated to show the Free/Busy times of the user, making it easy for you to plan the new 
appointment.

To use the Free/Busy times, the Public Store on the Zarafa server must be available. All the Free/Busy 
times will be stored in an invisible folder in the Public Store. If a user did not yet login with Outlook or 
Webaccess and did not create an item in the calendar, the Free/Busy times will not be available.

2.3.10  Resources

Everyone knows the problem, you want to arrange a meeting with some customers but you first need to 
check at the reception if there is a meeting room available. Since Zarafa version 5.20, the Resources 
feature is introduced.

Via the resource feature the availibility or scheduling of meeting rooms, beamers, cars or other limited 
objects in the company is made easy.

The resources work via the Outlook Freebusy Times & meeting request feature. Resources are by 
default available in all Outlook versions with the Zarafa 5.2x client or higher installed.

You can schedule a resource via the following steps:

1.Create a new appointment in Outlook

2.Open the tab “Scheduling”
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Screenshot 65: Freebusy information

3.Add the name of the resource or select the resource from the Global Address book

4.Change the icon “Required attendee” to “Resource or Equipment” 

Screenshot 66: Select the option “Resource”

5.Add the other attendees, that will join the meeting

6.Select a free timeslot via the freebusy times and send the meeting to the  attendees

7.If the resource is available in this timeslot, a pop-up will show that the resource is successfully 
booked.

Screenshot 67: Pop-up after the resource is successfully booked

8.If the resource is unavailable, a different (free) timeslot needs to be selected.

2.3.10.1  Tips and tricks

When you plan an all day event, make sure the appointment is booked as busy or out of the office. By 
default all days events are set as free and not visible in the freebusy times.
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2.3.11  Out of Office Assistant

If you click in the menu of Outlook on Tools you will find the Out of Office Assistant.  In this dialog you 
can set your auto-respond message.

The first time you restart Outlook, it will assume you have returned, and will produce a pop-up asking if 
you want to disable the auto-respond message again.

This message is the same as the one you can set with the Webaccess.

2.3.12  Rules

Select your Inbox folder, and click in the menu of Outlook on Tools and select Rules and Alerts. Here 
you will be able to create rules which are processed on the server when a new email arrives.

Screenshot 68: Rules wizard.

There are certain limits on the types of rules you can make. The condition of the rule can be in any form.

Note: If you are using Outlook 2003 or 2007, any rule created will automatically have an option called 
'on this machine only'. You need to remove this option so the server can execute this rule for you.

You can only choose to copy/move or to delete a message.  Other actions are not possible at this time. 
You may create these rules, but they will not be performed on the server. An example of such a rule is 
to send the mail to the printer, or forward it directly to another email account.

Local rules can still be performed manually by clicking on the Run rules now button in the Rules and 
Alerts dialog.

Rules can only be used in Outlook 2002/XP and up. Outlook 2000 is not supported.

2.3.13  Signatures

Signatures can be set in the Options menu of Outlook.  It is important to note that signatures set in 
Outlook are separate from those set in the Webaccess.  You need to set the signature in both clients 
separately.

2.4  Digital signatures and encryption
Since Zarafa 6.10 it is possible to use S/Mime certificates. Certificates enables the use of digitally 
signing emails and/or encrypting emails.
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The description in this manual is the manual procedure. An automatic way to receive a certificate is to 
use Active Directory Services (ADS). The automatic method is not described in the client manual, but 
will be described in the server manual.

2.4.1  Retrieving a certificate

In order to get a certificate a registration at a Certificate Authority (CA) is needed. Multiple possibilities 
are available; one is to have your Active Directory (AD) act as a CA, the other is to subscribe to an 
independent CA, like CaCert (www.cacert.org).

2.4.1.1  Certificates via AD

•The company's AD is configured to act as a CA:

•Open Internet Explorer

•Go to the following URL: http://<domainserver>/servcrt. If the URL is different, ask your systems 
administrator for the correct URL.

•Click on 'Request a certificate' and on the next page on 'User Certificate' to generate a certificate.

•The certificate will be placed into Outlook automatically.

2.4.1.2  Certificates via an independent CA

•Go to the site of the CA.

•Register your email address and create a certificate.

•Use Firefox to retrieve the certificate.

•In Firefox, go to Tools → Options → tab Advanced → tab Encryption → button 'View Certificates'

Screenshot 69: Certificate Manager
• Select the correct Certificate and push the button 'Backup'.

• Enter a password.

• Save your certificate as a 'PKCS12 file'.

• Open Outlook.

• Go to Tools → (if Outlook 2003: Options) → tab Security → button 'Import/Export...' → button 
'Browse...'

• Select the correct .P12 file.

• Enter the previous password.

• Enter in the field 'Digital ID Name:' the email address for which the certificate is meant.

• Push button 'OK' twice.

p.42

http://www.cacert.org/


2.4.2  Check encrypted email settings

• Go to Tools → Options → tab Security → button 'Settings...'

• Check if the field 'Security settings Name:' contains the S/MIME settings for your email address.

Screenshot 70: Security Settings

2.4.3  Using the certificate

After entering the certificate into Outlook it can be used to digitally sign your emails or let others send 
encrypted emails to you.

If you open a new email or reply to an email you will see two new icons: 

: the option to digitally sign messages.

: the option to encrypt the message contents and attachments.

2.5  Fax Feature
Since version 6.20 it is possible to send fax through Outlook 2003/2007 and a third-party software such 
as Hylafax.

In order to send a fax:

1.Open the new e-mail window by clicking the File menu and selecting New and then Mail Message 

2.Go on Options, Format and choose Plain Text

3.Fill in the To: field with the following syntax: [fax: fax number]

4.Fill in the From: and Subject fields as they will appear in the fax cover.

5.Enter the mail body as you would do for a normal mail message

6.Click Send

p.43



Screenshot 71: New fax item.

Note: In order to have a fax available an administrator needs to install or set things in order on the 
server. An administrator can find some additional information here: 
http://zarafa.com/wiki/index.php/Fax_server_integration

2.6  Delegation
Since Zarafa 6.20 two kinds of delegation are available:

•Send on Behalf permissions: if a user grants the appropriate permission to another user, the latter can 
send items 'on behalf of' the other user. In this case an email or meeting request will be sent with the 
following From: field: <delegate> on behalf of <user>.
The option to add delegates is available in the Options menu of Outlook.

Screenshot 72: Zarafa delegates.

•Send As permissions: if the system administrator gives the rights to user B to 'send as' user A, the 
receiver of an email will not see that user B sent an email. The receiver will only see user A in the From: 
field. See the server manual how to configure the Send As permissions.

Screenshot 73: Show FROM: field in new email.

Before version 6.20, a user could enable send on behalf of permissions. This meant letting a user send 
an email 'on behalf of' another user from inside the inbox of the other user. You could always see who 
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sent the email. For example: Pete enters the inbox of 'info' and sends an email as the non-active user 
'info', you would see: “pete@example.com on behalf of info@example.com”.

Since 6.20 it is possible to send emails as other users without the 'on behalf of' part. Due to security 
reasons the new 'send as' permission is only configurable by the administrator on the server side. This 
setting can always be overruled by the user itself and the old 'on behalf of' permission can still be set by 
the user.

Note: If the following (bounce) message is returned when sending an email not as yourself, please 
contact your administrator:

“You are not allowed to send as the given user.”

Due to the introduction of the Send As permissions in Zarafa 6.20 the previous abilities to send 
'on behalf of' are reset when updating to this version; an administrator or the user who wants to 
delegate has to give the rights or permission again:

Keep in mind that Send on Behalf permissions always overrules Send As permissions so a user 
can always choose not to let another user (mis)use send as permissions.

2.7  Categorisation
Since version 6.20 it is possible to categorise the items in Outlook by default categories and by 
customized categories.

2.7.1  Create a custom category in Outlook 2007

To create a custom category click on the Categorise button in the Outlook toolbar and choose All 
Categories. 

The Color Categories window will appear; choose New to add a new category.

The New Category window will appear; fill in the name of the category, choose a color to represent it 
and optionally a shortcut key.

Click on OK and the new category will be automatically added to the available categories in the Color 
category window.

  
Screenshot 74: Add category in Outlook 2007

2.7.2  Create a custom category in Outlook 2000/2003

1.Open a new mail and choose in the taskbar for options.

2.Choose in this window (message options) for categories, and then for Master category list.

3.Type the name for the new category and add this with the Add button.
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4.After creating the category, confirm with the OK buttons in the open windows.

Screenshot 75: Add category in Oulook 2000/2003

2.7.3  Categorise items and sort by category

In order to categorise an item (it is possible to categorise Mail, Contacts and Appointments) right click 
on it, choose Categorise and then click on the desired category.

To order the items by category open the View menu, choose Arrange by or Current View and then 
Categories.

2.8  Mail expiration date
Since version 6.20 it is possible to set an expiration date for the outgoing mail.

When writing a new mail, this setting can be found under Options --> More Options; the Message 
Options window will appear.

Tick the Expires after option and set the expiration date.

Screenshot 76: Message options.
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2.9  Advanced configuration
Since version 6.20 two new settings are introduced in order to improve connection to your Zarafa 
server.

Screenshot 77: connection settings

2.9.1  Proxy settings

If the zarafa server is only reachable via a proxy server it is possible to enter the information of the 
proxy server into the client settings.

2.9.2  Other connection settings

Two other connection settings are configurable:

•Compression: Uncheck this option if compression is not wanted. This option is on by default.

•Server connection timeout: Depending on the quality of your connection it is possible to change the 
timeout to the zarafa server. Default is 30 seconds.

2.10  Public Folder favourites
To have a useful shortcut to the most used public folders use the Favourite folder that can be found 
under the public folders tree. In order to add a folder to the Favourite folder, right click on a public folder 
and select 'Add to Zarafa favourite folder'. In outlook 2007 the 'Add to Favourites' window will appear 
(screenshot 78). In Outlook 2000/2003 the shortcut will be added directly in the favourites folder.

By default only the selected folder will be inserted in the favourite folder without subfolders. It is 
necessary to specify otherwise.

Screenshot 78: Add to favorites window (Office 2007)
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3  Zarafa IMAP and POP3

3.1  Client configuration
Every client supporting IMAP4 or POP3 should be able to  connect to Zarafa via the Zarafa IMAP & 
POP3 gateway. 

For sending mail clients will use SMTP. The smtp server can be the same as the Zarafa server or the 
smtp server of the internet provider. Some servers need SMTP authentication. SMTP username and 
password are not related to the Zarafa username and password. The client can store sent messages in 
a Sent Items folder.

3.1.1  Mozilla Thunderbird

This manual is based on Mozilla Thunderbird. Other versions can be set up in a similar way.

The first 2 steps can be skipped when opening Thunderbird for the first time. The following example is 
for the IMAP protocol. The POP3 protocol is practically the same without steps 10 to 12.

1.Go to Tools → Account settings... 

Screenshot 79: Tools dropdown menu.

2.Click ”Add Account”

3.Select “email Account” and click 'Next'

4.Fill in your name and Zarafa email address and click 'Next'.

5.Select “IMAP” and fill in the Zarafa server's hostname or IP address. Click 'Next'.

6.Fill in the Zarafa username for the “Incoming username” and  the “outgoing username”. Click 'Next'.

7.The “account name” can be chosen by the user itself. Click 'Next'.

8.Check the data and click “Finish”.

9.Open the Inbox and type in your password to receive the folder structure from the Zarafa server

10.Go to “Account settings...” and select the “Server Settings” in the previously made account.

11.Set the security to the desired level (default is 'Never').

12.Select “Copies & Folders” in the account tree and set the correct foldernames on the IMAP server.

13.Finally Click 'OK' and start using Zarafa with the IMAP protocol.
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3.1.2  Windows Mail

This  example is based on Windows Mail. Outlook Express can be configured in a similar way.

The following example is for the IMAP protocol. The POP3 protocol is practically the same without steps 
10 to 12.

1.Go to Tools → Accounts

Screenshot 80: Tools dropdown menu

2.Click “Add..”

3.Select “Email Account” and click 'Next'.

4.Enter the “Display Name” and click 'Next'.

5.Enter the “Email Address” and click 'Next'.

6.Select “IMAP” from the dropdown menu, fill in the Zarafa server's hostname or IP address and the 
hostname or IP address of the outgoing mailserver.

7.Optional: check whether the outgoing server needs authentication and click 'Next'.

8.Fill in the Zarafa username in “Email Username” and the Zarafa password. Click 'Next'.

9.(Un)tick whether the user wants to download the data from the server right away and click 'Finish'.

10.Highlight the new account in the folder list and click “Properties” in the right click context menu.

11.Select the “IMAP” tab.

12.Check whether the “Special Folders” is ticked and the folders are set the same as the Zarafa folders.

13.Finally Click 'OK' and start using Zarafa with the IMAP protocol

4  Zarafa CALDAV and iCal

This chapter describes how to configure the CALDAV or iCal client for using with the Zarafa server. The 
zarafa-ical gateway enables users to view their Zarafa calendars using clients like Sunbird, Evolution or 
Mac iCal.

To access calendar folders on Zarafa the following options are available:

URL Calendar

http://server:8080/ical/ user's own default calendar via ical (not 
recommended)

http://server:8080/caldav/ user's own default calendar

http://server:8080/caldav/<other-user> Other-user's calendar list
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http://server:8080/caldav/<user>/<calendar> user's self created calendar in user's (own) store

http://server:8080/caldav/<user>/<calendar>/<su
bcal>

user's self created subcalendar in a self created 
calendar

http://server:8080/caldav/public/<calendar>/ Calendar folder in the public folder.

URL For MAC OSX ical client

http://server:8080/caldav/ User's calendar list

http://server:8080/caldav/<other-user> Other-users calendar list

http://server:8080/caldav/public Public folders list

Note: The <other user> or <user>/<calendar> is only reachable if the correct permissions are 
available.

Note: The mac iCal client is fully tested and supported up to 10.5.6.

4.1  MAC OSX ical client.
1.You need to be running the Mac OS X 10.5 Leopard release for a version of iCal supporting CALDAV.

2.Start ical 

3.Go > Applications > ical

4.Click iCal from menu and select Preferences.

Screenshot 81: iCal dropdown menu

5.Click on '+' to create new account.
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Screenshot 82: Account details

6.Fill in the details.
Add server address as: http://Zarafaserver:8080/caldav/

7.Click on Add to retrieve the calendars of the user.

Screenshot 83: Account created

4.2  Sunbird Client Guide
1.Start Sunbird client.

2.Click on File in the menu bar and select “New Calendar”.

3.Select option “on the Network”. Click 'Next'.

Screenshot 84: New calendar location

4.For icalendar, Select the iCalendar Option.
Enter as location: http:://zarafaserver:8080/ical

Screenshot 85: iCal details

1.For caldav, select CalDav option.
Enter as location: http://zarafaserver:8080/caldav
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Screenshot 86: CalDav details

4.3  Evolution Client Configuration
1.Start Evolution client.

2.Click on menu “New”. Select “Calendar”.

3.Fill in the Details & remove the “Use SSL” option.
The URL options are similar to sunbird.

Screenshot 87: CalDav details

5  Mobile clients

This chapter describes how to configure the Z-Push software to synchronise PDA's and Smartphones 
with a server based solution.

Z-Push is available as an opensource project on Sourceforge - http://z-push.sourceforge.net
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5.1  Z-push introduction
The Z-Push software allows users with PDA's and Smartphones to synchronise their email, contacts, 
calendar items and tasks directly from a compatible server over UMTS, GPRS, WiFi or GSM data 
connections. The following devices are native supported by Z-Push:

•PocketPc 2002 and 2003

•Windows Mobile 5 and 6

•Nokia E-series

•Sony Ericsson P990, W950 and M600

•All other ActiveSync compatible devices

•Apple Iphone

The devices can be synchronised because the Z-Push module emulates an MS Exchange server on the 
server side, allowing users to synchronise without installing specialised synchronisation software on 
their devices.

Z-Push supports the following backend server technologies:

•Zarafa Zarafa is a workgroup sharing solution based on the look-and-feel of Microsoft Outlook, 
which enables sharing of mail and appointments from Outlook and a web based interface.

•IMAP is a widely used mail protocol with folder support. 

•Maildir Maildir is a simple mail solution available on almost every Linux system. All mails are 
stored in specific directories on the server.

•Vcard Implementation used to synchronize vCard files with contacts on the PDA.

5.2  Setting up your mobile device.
It is simply a case of adding an 'exchange server' to your activesync server list by specifying the IP 
address of the Z-Push apache server, disabling SSL, unless you have already setup SSL on your 
Apache server, setting the correct username & password (the domain is ignored, you can simply specify 
'domain' or some other random string), and then going through the standard activesync settings.

Once you have setup your mobile device, you should be able to synchronise your device simply by 
clicking the 'Sync' button in ActiveSync.

5.2.1  Activesync based configuration

The following steps are made for the PocketPC, though still applicable for WM 5/6 or mail for Exchange:

1.Open ActiveSync and select 'set up your device to sync with it'
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Screenshot 88: Activesync introduction

2.Type your server address (without http or other URL parts)

Screenshot 89: Server address

3.Specify your username and password, you must specify a domain but it is not used within Z-Push, so 
you can specify simply 'domain' or some other random text. Select 'save password' if you wish to 
automatically sync.

Screenshot 90: Account details

4.Select which items must be synchronised.
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Screenshot 91: Synchronise options

5.Press 'Finish' and start synchronising by pressing 'Sync'

5.2.2  Iphone based configuration

The following steps are applicable for the Iphone:

1.Open Settings and touch 'Mail, Contacts, Calendars'

2.Touch “Add Account...” and touch “Microsoft Exchange”

  
Screenshot 92: Mail, Contacts, Calendars settings, Choice protocol/provider.

3.Enter the user credentials. And touch 'Next'
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Screenshot 93: User settings.

4.The device will try to contact the server. If the server is not equal to 'zustomer.com' in this case, the 
connection will fail.
If the server is not configured for SSL connections, the connection will fail too. Iphone has SSL enabled 
by default.

5.A new option field “Server” will popup. Enter the correct server address or IP if necessary.

Screenshot 94: Extra server field.

6.If SSL not available: The connection will fail. Touch 'Save' in order to keep the current account 
settings. Go to the just made account and touch “Account info” and disable “Use SSL”.

  
Screenshot 95: Save settings and Account settings.
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